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1. Introduction 

 

Helios is a real-time vehicle tracking device designed for fleet management 

and security applications. 

 

It offers over 200 unique features, such as fuel consumption monitoring, extra 

digital inputs for connection of various external sensors, offline communication 

option, built-in accelerometer, OTA (over-the-air) programming, and more. 

 

The system allows to configure a wide variety of events for fleet manager and 

the communication channels which define where and how the notifications are 

transmitted. 
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2. Package Contents 

 

 

 

1. Helios unit 

2. Helios wire harness 
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Helios evaluation kit 

 

 

 

Evaluation kit package includes: 

1. Simulator 

2. Simulator power supply 

3. Simulator to Helios connection cable 

4. Simulator USB to Mini USB cable 

5. RS232 cable 

6. Keypad 

7. Two Dallas keys and Dallas socket 

8. Three Helios units with wire harnesses 
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Simulator description 

 

The Simulator was developed for Helios testing and presentation purposes. It 

simulates the vehicle behavior and alarm triggers. The LEDs light up to indicate 

the unit input/output response. It can serve as an efficient tool in training your 

employees and evaluating their performance. The Simulator is an effective, 

professional sales tool which can be used to demonstrate the system 

advantages and present them to your customers. 

 

Front panel 

 

 

1. Power LED 

2. Dallas Key socket 

3. Analog input knobs 

4. Output simulator LEDs 

5. Input simulator buttons and LEDs 
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Left panel 

 

1. DLS/KYPD – Dallas Key / Keypad switch 

2. Mini USB connector 

3. ON/OFF – Power switch 

4. Power connector 

 

Right panel 

 

1. 24-pin connector 
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Back panel 

 

 

1. Keypad connector 

 

NOTE: When connecting a keypad, make sure to place the DLS/KYPD switch 

on the left panel in the KYPD position. 

 

  

 
1 
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3. Product Description 

 

 

 

1. Bottom cover – plastic cover which snaps onto the top cover and is secured 

with a screw. 

2. Battery – backup battery (optional).  
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3. Divider – plastic divider which snaps onto the top cover. The backup battery 

is placed on top of this divider. 

4. Unit board – printed circuit board with electronic components which is 

secured to the top cover. 

5. Top cover – plastic cover which covers the GPS antenna. This side should 

be facing upwards when the unit is installed in the vehicle. 

 

Unit board main components 
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1. GSM modem 

2. GSM antenna 

3. GPS chipset 

4. SIM card holder 

5. 24-pin / 10-pin connector 

6. Fuse 

7. GPS antenna 
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Helios models 

 Helios 

TT 

Helios 

Basic 

(discontinued) 

Helios 

Advanced+ 

Helios 

Hybrid 

GPS     

GSM    

(optional 3G, 

HSDPA and 

CDMA) 

 

(optional 3G, 

HSDPA and 

CDMA) 

Satellite 

Connectivity 
- - -  

Connector 10 pin Molex 10 pin Molex 24 pins 

Molex 

24 pins Molex 

+ 

10 pins Molex 

Accelerometer  -   

CAN Bus -    

Usage Track and 

trace 

Track and trace 

 

Basic functions 

Full fleet and 

security 

features 

 

Can be used 

as 

standalone 

alarm system 

Full fleet and 

security 

features 

 

Can be used 

as standalone 

alarm system 

Advantages Low cost 

 

Waterproof 

IP65 

(optional) 

 

Allows a tow 

detection 

with very 

low power 

consumption 

Low cost 

 

Quick 

installation 

 

 

Additional 

inputs/output

s 

 

Built-in 

accident and 

harsh 

braking 

detection 

 

Additional 

inputs/outputs 

 

Built-in 

accident and 

harsh braking 

detection 

 

Constant 

communication 

around the 

world, even 

without 

cellular 

coverage 
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I/O 2 digital inputs 

(one digital 

input can be 

used as an 

analog input) 

 

1 digital output 

 

1 COM port 

1 digital input 

 

1 analog / 

digital input 

 

1 digital output 

 

 

RS232 

 

iButton / 

Keypad / 

Remote 

Control input 

8 digital inputs 

 

3 analog inputs 

 

4 digital outputs 

 

1 pulse counter 

 

 

 

RS232 

 

Can Bus 

 

*Hands Free input 

 

iButton / Keypad / 

RF Keypad / 

Remote Control 

input 

 

8 digital inputs 

 

3 analog inputs 

 

4 digital outputs 

 

1 pulse counter 

 

RS232 dedicated 

to Hybrid module 

 

Can Bus 

 

*Hands Free input 

 

iButton / Keypad / 

RF Keypad / 

Remote Control 

input 

SIM 

card 

 
Micro-SIM (3FF)  

Mini-SIM (2FF 

or Standard 

SIM) 

 
Mini-SIM (2FF or 

Standard SIM) 

 
Mini-SIM (2FF or 

Standard SIM) 

 

* When Hands Free Kit is used, the unit is left with 5 digital inputs and 2 analog 

inputs only. 

 

For connector pin out information, see Helios TT pin out, Helios Basic 10-pin 

pin out and Helios Advanced+ 24-pin pin out (Chapter 6 – Installation). 
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Technical specifications 

CPU Type 

Memory 

NXP ARM Cortex-M3 

Static RAM: 128kb 

ROM: 34kb 

Flash: 2048kb 

 

Power Voltage Range 

 

 

Consumption 

8 V – 28 V (supported in same 

unit) 

 

3 mA in low power mode 

up to 120 mA in working mode 

can reach up to 300 mA if battery 

is charged 

 

Backup Battery 

(optional) 

 

Type 

Power 

Lithium-ion Polymer 

3.75 V, Helios Advanced+: 950 

mAh / Helios TT: 550 mAh 

 

GPRS – Cellular 

Modem 

 

 

 

 

Satellite Modem 

(external device) 

 

Data Messages 

 

GSM 

 

Antenna Type 

Network Channels 

 

 

 

Connection 

 

 

SMS 

GPRS 

 

Quad Band (850, 900, 1800, 

1900). 

Built in (concealed) 

GSM, CDMA, HSDPA, SMS 

3G (optional) 

 

 

RS232 

 

 

Encrypted Protocol 

TCP/IP 

 

Location 

 

Type 

Time to First Fix 

(TTFF) 

Positioning Accuracy 

 

 

Antenna Type 

GPS / GLONASS (optional) 

2 sec (hot start) 

 

10 m CEP (50%) 

Velocity: 0.2 m/s (50%) 

 

Built in (concealed) 

 

COM Port 

 

Type 

Speed 

RS232 

115,200 bps (default) 

 

I/Os 

(check per model) 

 

Digital Inputs 

 

Digital Outputs 

 

Analog Inputs 

 

Pulses Counter 

 

CAN Bus 

Helios Advanced+: Max 8 / Helios 

TT: Max 2 

Helios Advanced+: Max 4 / Helios 

TT: Max 1 

Helios Advanced+: Max 3 / Helios 

TT: Max 1 

Max 1 (Helios Advanced+ only) 
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 Included (Helios Advanced+ / 

Basic) 

 

Accelerometer 

(check per model) 

Type 

Purpose 

3-Axis, 20 mg accuracy, up to 8 g 

Identify and report events of 

impact, accident 

 

Alarm System 

 

Immobilizer 

Disarming Options 

 

External – Gradual Stop 

Keypad, Dallas Key, Remote 

Control, RF Keypad 

 

 

Dimensions 

 

Size 

 

 

 

 

 

 

 

Weight 

 

Helios Advanced+:  

21H x 60W x 107L (mm) 

0.82H x 2.36W x 4.21L (inches) 

 

Helios TT:  

21H x 60W x 57L (mm) 

0.82H x 2.36W x 2.24L (inches) 

 

Helios Advanced+:  

150 (grams) 5.29 (Oz) 

 

Helios TT:  

120 (grams) 4.23 (Oz) 

 

Environmental 

 

Operating Temp 

 

Storage Temp 

 

Humidity 

 

-40°C (-40°F) to 60°C (140°F) 

 

-40°C (-40°F) to 85°C (185°F) 

 

Max 50% 

 

 

 

Industry approvals and certifications 

 

 

For available certificates, see: 

http://wiki.starcomsystems.com/wiki/index.php/Marketing#Certifications. 

  

http://wiki.starcomsystems.com/wiki/index.php/Marketing#Certifications
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4. Configuration 

 

Downloading the Software 

For the link to download the Installer application setup file, please contact 

Starcom technical support by Email: support@starcomsystems.com, or 

Skype: starcom.support. 

 

Installing the Software 

Locate the folder where you saved the installer setup file. Double-click the 

InstallSetup.exe. The Open File dialog box appears. 

 

 

Click Run. A Windows Security dialog box appears. Click Yes. The Welcome to 

the Starcom Installer Application Setup Wizard window appears. 

  

mailto:support@starcomsystems.com
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Click Next. The Select Destination Location window appears. 
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Click Next. The Select Components window appears. 

 

Click Next. The Select Start Menu Folder window appears. 
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NOTE: Select Don’t create a Start Menu folder checkbox, if you do not want 

to create a start menu folder. 

Click Next. The Ready to Install window appears. 

 

Click Install. The installation starts and a progress bar appears in the window, 

indicating the progress of the installation. 
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When the installation is complete, the Completing the Starcom Installer 

Application Setup Wizard window appears. 

 

Click Finish. 

 

Installing the Update 

To install the Installer update software, locate the folder where you saved the 

update file. Double-click IUpdate.exe. The Open File dialog box appears. 
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Click Run. The Starcom Installer Update window appears. 

 

Verify that the Destination folder points to the location where the Starcom 

Installer software is installed and click Install. A Windows Security dialog box 

appears. Click Yes. The Confirm file replace dialog box appears. 

 

Click Yes to All. The installation starts and a progress bar appears in the 

window, indicating the progress of the installation.  
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The Starcom Installer Update window closes, when the update is complete. 

 

  



 
 

26 
 

Helios User Guide 

Inserting the SIM card 

Use a small Phillips screwdriver to remove the screw from the bottom cover. 

 

 

Insert a flat screwdriver in the slot between the unit covers. Carefully twist the 

screwdriver to lift and open the unit cover. 
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Gently push and pull back the plastic SIM card holder to release and open the 

SIM card slot. Raise it to an upright position. 

 

 

Insert the SIM card in the SIM card slot with its gold contacts facing down and 

its cut-off corner facing out the SIM card slot, as shown in the following image. 
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Lower the SIM card holder back to the horizontal position. Gently press and 

push the SIM card holder forward to snap it back into place. 

 

 

 

Attaching the battery (optional) 

NOTE: Connecting the battery to the unit must be carried out very carefully. 

Use caution to avoid causing damage to the battery and the unit. 

 

Place the battery on the divider, as shown in the following image. 
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Verify that you’re connecting the battery connector to the connector on the 

unit board correctly. The side of the battery connector with the pinholes located 

closer to the edge 

 

 

must be connected to the corresponding side of the connector on the unit 

board. 
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Carefully insert the battery connector into the connector on the unit board. 

 

 

Gently push the battery connector into the connector on the unit board. If 

necessary, use a small flat screwdriver. Be careful, do not use excessive force! 
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Snap the divider on the top cover and place the battery on it as shown in the 

following image. 

 

 

Place the bottom cover so that the battery cable is coiled around the plastic 

pin of the bottom cover screw. 

 

 

Align the top and bottom covers, and push them firmly together until they click 

and lock into place. Insert and tighten the screw. 
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Connecting the unit to the computer 

There are two ways to connect the unit to the computer: 

 

1. Using an RS232 cable and a power supply 

Connect the Helios wire harness RED Power cable (Pin 5) and YELLOW Key 

cable (Pin 4) to 12 or 24 V plus (+) on the power supply. 

Connect the Helios wire harness BLACK GND cable to the 12 or 24 V ground 

(-) on the power supply. 

Connect the RS232 cable to the RS232 connector on the Helios wire harness 

and to the COM / USB port on the computer. Install the RS232 cable driver on 

your computer. 

 

 

 

For Helios TT, use the TTL cable supplied with the unit and the driver from the 

following link: http://www.ftdichip.com/Drivers/VCP.htm. 

 

NOTE: This method can be used to connect the unit to a portable computer, 

when the unit is installed in the vehicle.  

http://www.ftdichip.com/Drivers/VCP.htm
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2. Using a Simulator 

Connect the Simulator to the computer by using the USB to Mini USB cable. 

Connect the Helios unit to the Simulator. Connect the Simulator power supply 

and plug it into an electrical outlet. Turn the Simulator on. 

 

 

 

Install the Simulator driver on your computer. The Simulator driver can be 

downloaded from the following link: 

http://wiki.starcomsystems.com/wiki/images/CP210x_VCP_Win_XP_S2K3_Vi

sta_7.exe 

 

For connecting Helios TT and Helios Basic to the Simulator, see pages 67 and 

70 (Chapter 6 – Installation). 

  

http://wiki.starcomsystems.com/wiki/images/CP210x_VCP_Win_XP_S2K3_Vista_7.exe
http://wiki.starcomsystems.com/wiki/images/CP210x_VCP_Win_XP_S2K3_Vista_7.exe
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Configuring the unit 

To open the Installer application, from the Start menu select Starcom 

Systems > Installer Application. The Installer company name window 

appears. 

 

 

Enter your company name and click OK. The Installer window appears. 

 

 

Click Technical > Communications, or press the Communications button 

 on the taskbar at the top of the window.  
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Click the Advanced button . The Communications Window will 

appear. 

 

 

Click the Add button . The Network Selection window appears. 
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Select Helios from the list and press OK to add a Helios network. 

 

The Communications Window will now display the new connection, which is 

named Helios 1, in the Available Networks list. 

 

 

Click on Helios.1 button to configure and activate the connection. 
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Select the COM port number of the RS232 or the Simulator cable port in the 

Com Port dropdown list. 

In order to verify the COM port being used by the unit in your computer, go to 

My Computer > Manage > Device Manager > Ports. 
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Set the Baud Rate to 115200. Check the Activate checkbox and click Save. 

 

If Helios has connected successfully, a "Helios.1: on" notification will appear in 

green color at the bottom left corner of the Installer application main screen 

 . 

 

To access the unit parameters, press Technical > Helios Parameters, or 

click on the Helios Parameters button  on the taskbar at the 

top of the Installer application window. 

 

 

Press the Read from unit button  to read the parameters 

already configured in the unit. 
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General settings 

This tab allows you to configure the way the unit will register and calculate the 

distance traveled by the vehicle. 

 

 

 

Mileage (kilometers) – current mileage displayed on the vehicle dashboard. 

Fixing Factor (%) – a factor to use when calculating mileage by GPS. The 

default value is 100%. If, for example, there is a constant offset of 25% below 

the actual mileage, this value should be changed to 125%. 

Mileage From – in this dropdown list, you can select the method to use for 

mileage calculation: GPS or Odometer. 

Odometer Counting – if you chose to use odometer for mileage calculation, 

configure the following fields: 

Current Value – number of kilometers as shown in odometer. 

Pulses Per KM – odometer pulses per one kilometer. 

For more information, see Appendix B – Configuring Mileage.  
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Network settings 

This tab allows you to enter all the parameters necessary for the unit to 

connect to the network. 

 

 

 

SMS Destination 

The unit transmits via GPRS by default and via SMS as a backup, when GPRS 

connection is not available. The number to be entered in the SMS Destination 

field is the SIM card number used in the SMS Terminal unit connected to the 

routing server, or the SMPP target number. For more information, see SMS 

Notifications guide. 

 

APN settings 

The APN settings are essential for the unit to transmit messages and alerts. 

The APN settings are provided by your cellular operator with the SIM card you 

are using in the unit. 

  



 
 

41 
 

Helios User Guide 

GPRS APN (Access Point Name) – the name of the gateway provided by your 

cellular operator (e.g. internet). 

GPRS Username – username provided by your cellular operator (e.g. blank). 

GPRS Password – password provided by your cellular operator (e.g. blank). 

 

First server – main routing server, which the units transmit to (by default, it 

is Starcom Systems server 1). 

Secondary server – auxiliary routing server, which the units transmit to (by 

default, it is Starcom Systems server 2). 

Port – port open for communication on the routing server (default port is 

6600). 
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Transmission Rates settings 

This tab allows you to configure the intervals of regular tracking transmissions, 

which define how often the unit will transmit its status. 

 

 

 

Home network – transmission rate in home GSM network. 

Roaming network – transmission rate in roaming GSM network. Select this 

option if the unit will travel across borders. In order for this to work, the SIM 

card used in the unit must have a roaming service enabled by your cellular 

provider. 

Offline mode (saved to memory) – transmission rate when the device is 

out of cellular coverage. 

NOTE: When the device is out of GPRS coverage, and the SMS interval is set 

to None, the messages will be saved to the unit memory according to the 

intervals entered in the Offline mode fields.  
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SMS – transmission rate for transmissions via SMS. 

GPRS – transmission rate for transmissions via GPRS. 

NOTE: The unit transmits via GPRS by default and via SMS as a backup, when 

GPRS connection is not available. For more information, see Appendix A – Unit 

Communication in Starcom Systems. 

 

Ignition On – transmission interval when the vehicle ignition is on. 

Ignition Off – transmission interval when the vehicle ignition is off. 

 

Send messages from the memory by: 

SMS – if this option is selected, missed and buffered messages will be sent by 

SMS as well. 

Roaming GPRS – if this option is selected, missed and buffered messages will 

be sent by GPRS in roaming networks as well. 

 

Send memory messages only when Ignition is OFF – when enabled, all 

the messages saved in the unit memory will be sent only when the vehicle 

ignition is off. This is done to let the unit freely transmit ongoing messages 

when the vehicle is traveling. 

 

Satellite Intervals – these parameters are to be used with Helios Hybrid only. 

For more information, see Helios Hybrid Configuration, page 63. 
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Inputs settings 

This tab allows you to configure the unit inputs activities and alerts. In addition, 

this tab allows you to configure the Main Power Low alert and the 

accelerometer alerts. 

 

 

 

Inverted – use to invert the input. 

Masked – use to mask the input. If enabled, the input activity will not be 

transmitted. 

Alert on Off – if activated, the unit will send the input Off alert. 

Alert on On – if activated, the unit will send the input On alert. 

Alert when Armed – if activated, the unit will send the input on alert when it 

is armed.  
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Use for Arm – will arm the unit when the state of the input changes. 

Use for Disarm – will disarm the unit when the state of the input changes. 

 

Ignition – ignition input, YELLOW cable on Helios wire harness (Pin 4). 

Door – door input, GREEN cable on 24-pin Helios wire harness (Pin 16). 

Emergency – emergency input, WHITE cable on 24-pin Helios wire harness 

(Pin 8). 

Arm input – arm input, ORANGE/WHITE cable on 24-pin Helios wire harness 

(Pin 14). 

Disarm input – disarm input, PINK cable on 24-pin Helios wire harness (Pin 

17). 

Extra Input 1 – ORANGE cable on 24-pin Helios wire harness (Pin 9). 

Extra Input 2 – GREEN/RED cable on 24-pin Helios wire harness (Pin 21). 

Extra Input 3 – BLUE/RED cable on 24-pin Helios wire harness (Pin 22). 

 

Main Power Low Alert (v) – the unit will send a low power alert when the 

voltage drops below the indicated value. 

 

Accelerometer alerts 

Harsh Braking – used to determine the sudden stopping of the vehicle, which 

is not desirable in the case of buses, trucks, freight transportation, etc. 

Accident Detector – determines a greater impact on the car and is usually 

used to track accidents. 

Force (g) – determines the threshold of the force needed to be measured in 

order to send an alert. Select "Disabled", if you don't wish to use the alert. 

Duration (msec) – determines the duration of the force needed to be 

measured in order to send an alert. 
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Quarter scale – if on, the Weak Impact force will be scaled in quarter of a g. 

This option can be used to make the accelerometer more sensitive to smaller 

impacts. 

 

NOTE: The default force and duration values are based on the laboratory 

testing results, they were found to be acceptable in most cases. These values 

can be tested and changed according to the specifics of your work. To change 

these values according to specific conditions, you need to test the unit with 

different values and choose the best option. The lower the setting, the more 

often the unit will respond to a weaker impact. 
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Outputs settings 

This tab allows you to configure the unit outputs activities and alerts. 

 

 

 

Locking – activates the settings for Helios Door Lock output. 

Unlocking – activates the settings for Helios Door Unlock output. 

Pulses – number of pulses to send in order to lock/unlock the vehicle. 

Width (s) – width of pulses 

Interval (s) – interval between the pulses, if there is more than one pulse. 

For more information, see Appendix C – Central Locking System Configuration. 
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Immobilizer – activates the settings for Helios Immobilizer output. 

On when Armed / Idle – the condition in which the unit will activate its 

immobilizer output. When connected using a Normally Open relay, this value 

should be set to Idle. When using a Normally Closed relay, set to Armed. 

 

Use keypad RF instead of Immobilizer output – used instead of 

immobilizer, when keypad is used to transmit driver codes to wireless relays. 

For more information, see Appendix H – Using Keypad with RF Relay. 

 

Gradual Stop Method – the unit can be used to bring the vehicle to a gradual 

stop, if necessary. For example, if the vehicle is reported as stolen, the control 

center can issue a Gradual Stop command. Here you can configure the method 

to use when a gradual stop command is sent to the unit. The Gradual Stop can 

be performed in Pulses – gradually, which is preferable, or Constantly – 

abruptly. 

ON Constantly / ON Pulses – select, if you’re using a Normally Closed relay. 

OFF Constantly / OFF Pulses – select, if you’re using a Normally Open relay. 

For more information, see Appendix D – Immobilizer and Gradual Stop. 
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Logic settings 

This tab allows you to configure the unit logic states. 

 

 

 

Auto (Un)Lock from Ignition – if activated, the unit will send a lock signal 

when the ignition is turned on, and unlock when it is turned off. 

GPS Off When Ignition Off – if enabled, turns the GPS off when the ignition 

is off. This helps to avoid the unit reporting vehicle movement, which can be 

caused by GPS "jumps", when it is actually stopped. 

Transmit after first start-up or restart – if activated, a Power On message 

will be transmitted whenever the unit is either powered on for the first time, 

or restarted. 
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The unit remains in one of its logic states at all times. The logic state can be 

changed automatically, according to the parameters configured in this tab, or 

manually, by using remote control, keypad, iButton, or over-the-air command. 

The following are the unit logic states: 

 Unarmed – unit state when immobilizer is not activated 

 Armed – the immobilizer is activated and the engine is off. The alarm 

system is active and ready. 

 Garage – the alarm system is disabled for a predefined period of time. This 

is useful, for example, when the vehicle is undergoing maintenance. 

 Silent Delay – the unit enters this state if triggered while in the Armed 

state. In this state, only the blinkers are activated. After a predefined period 

of time has elapsed in Silent Delay mode, the unit enters the Alarm 

Triggered mode. 

 Alarm Triggered – the system activates the siren. 

 

Unarm -> Arm – time to wait between the moment the ignition is turned off, 

and entering the arm state. If you do not want the unit to enter the arm state 

automatically, select None. 

Silent Delay -> Triggered – time to wait from the moment the alarm system 

has detected a break-in (for example, the ignition was turned on while the unit 

is armed), and until the siren is triggered. When using a keypad, or a Dallas 

Key, this will give the driver enough time to disarm the vehicle. 

Triggered -> Transmission – time to wait while sounding the siren until it 

will be stopped and a transmission will be sent. 

Maximum Garage Time – maximum time to stay in Garage mode. This 

setting is useful to avoid forgetting to disable the Garage mode manually. 
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The following image illustrates the logic states interchange. 
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Hardware settings 

This tab allows you to configure various hardware settings. 

 

 

 

The following settings relate to external text message devices. 

Use 57600 baud rate – if activated, the device will use 57,600 bps to 

communicate with external devices (such as MDT) through its RS232 port. 

NOTE: if the unit is connected to the computer directly with a cable, you have 

to change the baud rate in the Communications > Advanced window. 

RS232 Function – the protocol to be used by RS232 devices. 

Save failed text messages – if activated, the unit will save failed text 

messages that were sent via the RS232 port, according to the same logic that 

the Tracking messages are saved. 
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The following settings relate to the driver ID, keypad, and remote control use. 

Accept any driver ID code – if activated, any keypad code, remote control, 

or iButton can be used to disarm the unit. 

Use siren when arming/disarming by Remote Control or iButton – 

whenever the vehicle is getting armed from the remote control, two beeps will 

sound from the siren, and whenever the vehicle is getting disarmed from the 

remote control or iButton, one beep will sound. Also, whenever a new remote 

control or iButton is detected, one beep will sound. 

Use the Remote Control small button as an Emergency – if activated, the 

remote control small button will be used as an emergency button. 

Transmit when new driver is detected – each time a new driver is detected 

(using keypad, remote control, or iButton) a message will be transmitted. 

 

The following settings correspond to the unit Analog Inputs 1 and 2. 

0 – 15 V – the device will measure 0 to 15 V on analog input with an accuracy 

of 15 mV. 

0 – 27.5 V – the device will measure 0 to 27.5 V on analog input with an 

accuracy of 25 mV. 

Fuel Input – the input that will be used for fuel measurement. For more 

information, see Appendix F – Fuel Management. 
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Analog input configuration on Helios TT and Basic 

 

 

 

The analog / digital input on Helios TT and Basic units is configured as 

a digital (Door) input by default. 

To configure this input as analog, go to Helios Parameters > 

Hardware, and select 0-15v or 0-27.5v in the Analog 1 field 

according to the voltage range measured on Analog 1 input. 

Use the Analog 2 setting to indicate the input type as follows: 

0-15v – Analog input 

0-27.5v – Digital input 
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Fuel algorithm v2 

The new fuel calculation algorithm greatly improves the fuel level 

monitoring in Helios units. To use the new fuel algorithm, you must 

configure the Helios unit with the correct Analog input connected to the 

fuel tank, and the fuel graph slope. 

 

The slope is determined as the ratio between the voltage on the fuel 

tank and its contents. 

For example, if the voltage level is going down as the fuel tank is being 

emptied, then there is a direct ratio between them and therefore the 

slope is positive. In other words, a positive slope will appear if the full 

tank measurement is 10V, for example, and empty tank is 0V. 

 

If the fuel tank voltage level is increasing as the fuel tank is being 

emptied (which is the most common case), then the ratio between the 

voltage level and the fuel tank is an inverse ratio, and therefore the 

slope is negative. In other words, if the full tank measurement is 0V 

and half-full tank is 6V, then the graph line slope will be negative. 

 

In order to implement the new fuel algorithm, download and install the 

latest Installer version. In Installer, connect to the unit and run 

Firmware Update. Go to Helios Parameters > Hardware and enable 

the Fuel algorithm v2 option. 
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Verify what kind of slope you receive from the fuel graph and select the 

Fuel Input option in the dropdown list accordingly: 

Analog 1 - Positive slope – select this option, if you’re using the 

Analog 1 input for fuel level monitoring, and if the fuel graph line slope 

is positive. 

Analog 1 - Negative slope – select this option, if you’re using the 

Analog 1 input for fuel level monitoring, and if the fuel graph line slope 

is negative. 

Analog 2 - Negative slope – select this option, if you’re using the 

Analog 2 input for fuel level monitoring, and if the fuel graph line slope 

is negative. 

Analog 2 - Positive slope – select this option, if you’re using the 

Analog 2 input for fuel level monitoring, and if the fuel graph line slope 

is positive. 

Once all the necessary parameters are set, press the Send button to 

send the changes you made to the unit. 
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The following settings allow to configure full low power mode. If full low power 

is activated, when the vehicle ignition is turned off the unit shuts down all its 

major power consumers, such as modem, GPS, etc. This feature is intended 

for mopeds, motorcycles and other small vehicles, where the unit operation 

can drain the battery when the engine is off. 

Full low power – if activated, the device will switch to full low power 30 

seconds after the ignition is turned off, or when armed (if passive arming is 

available). 

 

Transmit when entering low power mode – the unit will send a message 

upon entering low power mode. 

Low Power Timing – how much time to wait after the ignition was turned off 

and until the unit enters low power mode. 

 

The following features are experimental and should be used with care. 

Transmit on turnings – if activated, the device will transmit each time a turn 

of over 30 degrees was detected. 

Tow detection – the device will alert if it was moved over 1 km from the 

location where it first entered the armed state.  

NOTE: This function works according to GPS readings. This means, if "GPS Off 

When Ignition Off" or "Full low power" options are activated in the unit, the 

Tow detection will not work. 

Measure RPM from Odometer input – if activated, the device will count the 

pulses in the Odometer value to calculate the vehicle’s RPM. 

 

The following settings allow you to configure the use of vehicle CAN bus. 

Can bus Vehicle / Type / Model / Year – here you can select the vehicle 

from the Helios database, which can be accessed from Technical > Helios 

Can bus. For more information, see Appendix G – CAN Bus Connection. 
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Jamming detection 

The jamming detection function is triggered if the unit detects two of 

more cell towers, but cannot connect to them due to interference. 

In order to implement this function, go to Helios Parameters > 

Hardware and enable the Jamming detection option. Press the Send 

button to send the changes to the unit. 

 

 

To configure the jamming alert, go to Starcom Online > Plans > 

Events > Types and create a Jamming event type by selecting 

Transmit Reason > Jamming and Set Output > Gradual Stop type 

options. 

Click Apply, go to Events and create an event for the unit based on the 

Jamming type. 

Click Apply and wait for several transmissions for the unit to receive 

the event and save it in its memory. For more information, see Chapter 

7 – Monitoring > Plans. 

If a jamming situation occurs, the unit will activate the event sequence 

immediately and send an alert once it reconnects to the cellular network.  
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Driver IDs settings 

This tab allows you to enter the driver codes to be used for arming and 

disarming the unit. 

 

 

 

To enter a code, click in the Code field and type the code. To add a new code, 

press New and enter a code. To remove a code, select it and press Remove. 

You can save and load lists of driver codes in *.csv format by using Load and 

Save buttons. 

You can enter up to 2000 codes. 

 

 

Once all the necessary parameters are set, press the Send button 

 to send the changes you made to the unit. 
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Saving the configuration 

If you are planning to configure other units with the same parameters, you can 

save these settings as a *.mem file. Click the Save button  in the 

Helios Parameters window, select the location where you want the 

configuration file to be saved on your computer, name the file and press Save. 

 

Configuring a new unit with the saved configuration 

To configure a new unit with the saved parameters, click the Load button 

 in the Helios Parameters window, browse to the location where you 

saved the configuration file, select the file and press Open. Click the Select 

All button  to select all the parameters and press the Send 

button  to send the changes to the unit. 

 

Configuring multiple units using the wizard 

In the toolbar, click Wizard. The Welcome to Starcom System window 

appears. 
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NOTE: Click the Always show the wizard on program startup checkbox, if 

you want the wizard to start each time you run the Installer application. 

 

Click Next. The Settings window appears. 

 

 

You can specify the settings manually by entering the GPRS Access Point 

Name (APN), or use a saved *.mem file to configure the unit with by selecting 

it in the Existing memory file field. 

Click Run connectivity test, if you want the wizard to perform a TCP test. 

Click Next. The Operation window appears. 
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Click Next. The Summary window appears. 

 

Select Exit wizard, and click Next. The unit is now configured and ready for 

testing and installation.  
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Helios Hybrid configuration 

Go to Helios Parameters > Hardware > RS232 Function and select Hybrid 

(19200bps) from the dropdown list. 

 

 

Then go to Transmission Rates > Satellite Intervals (Helios Hybrid 

Only) and configure the transmission rates. Use the Satellite Triggers 

(Helios Hybrid Only) fields to configure the event alerts. 
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5. Testing 

 

It is important to test the unit connection to the network, the correct GPS 

location, the unit status and inputs response before installing the unit in the 

vehicle. In order to do this, you need to perform the following steps. 

 

TCP test 

This test verifies that the SIM card is open to the GPRS network, the unit can 

connect to the network and make successful TCP/IP transmissions. 

Press the TCP Test button  (Communications > Advanced > 

Communication Window > Configuration > Helios.1). Wait a few minutes 

until you receive a pop-up window with a successful connection message. 

 

If at the end of the TCP Test you do not receive a successful message, check 

your APN settings (Helios Parameters > Network). Contact your cellular 

provider and make sure the SIM card is open for GPRS. Verify that your SIM 

card is not protected by a PIN code. If necessary, use a mobile phone to cancel 

the PIN code. 

You can also perform the test manually using the Terminal window. Open the 

Terminal window (Communications > Advanced > Communication 

Window > Configuration > Helios.1 > Open Terminal) and type the 

following commands: 

\tdm and press Enter (Modem mode). The modem will be turned on. 

\tr and press Enter. This command runs a series of actions to check the 

parameters such as reception level, visible networks and registered network, 

SIM card state and information. It also attempts to connect to the routing 

server. If successful, a "TCP: Send+" message will appear in the Terminal 

window.  
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GPS test 

NOTE: If you're testing the unit inside the building, it will not be able to get a 

GPS signal in most cases. In order to get a proper GPS location, the unit has 

to be placed outside the building, or outside the window, where it can access 

the satellites. 

Open the Terminal window (Communications > Advanced > 

Communication Window > Configuration > Helios.1 > Open Terminal) 

and type \tdg (GPS mode). GPS readings will be displayed. When you see 

"A,3"... reading, it will indicate a GPS fix signal. 
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If you do not see any response, type \tg1 to turn the GPS on and repeat the 

test. 

 

Unit Status 

Open the Unit Status window. Enter the unit number in the Unit Number 

field, select Request status and press Send. The unit information will appear. 

 

Click on the Inputs tab, press on the Key, Arm, Doors, etc. buttons on the 

Simulator, press Request status and check the response in the Unit Status 

window. Use the Outputs tab to test the unit’s outputs response. Use the 

Location tab to check the unit’s GPS data. Use the Various tab to see the 

unit information. 

 

After all the tests have been performed successfully, the unit is ready to be 

installed in the vehicle. 
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6. Installation 

 

WARNING: Failure to closely adhere to installation instructions may result in 

system malfunction and ultimately compromise the reliability of the entire 

system. 

It is assumed that installers are familiar with vehicle wiring and auto electrical 

devices. 

This chapter contains a selection of wiring options. Select the options best 

suited to your application. 

 

Wiring considerations and safety guidelines 

Always adhere to safety instructions to prevent possible injury and avoid 

damage to existing vehicle systems. 

Before beginning an installation, disconnect the vehicle battery. Notify the 

client that this erases the memory of all auto systems. It will have to be re-

programmed. 

Test the wiring only by using a LED test lamp or a voltmeter. Using other types 

of test lamps may cause high output currents and significant damage to the 

vehicle's electrical systems. 

Solder all the connections created during installation and insulate them using 

the electrical insulation tape and/or insulation sleeves. Twisting wires together 

without soldering them can result in loose connections and serious failures. 

There is the danger of explosion if the battery is incorrectly replaced. Replace 

the battery only with the same or equivalent type recommended by the 

manufacturer. Dispose of used batteries according to the manufacturer's 

instructions. 

Take special care to avoid damage to the cables of the vehicle's security 

systems, such as vehicle computer and air bags. Take note of this when testing 

voltage using a voltmeter or test lamp to prevent undesired system activation. 
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Only trained and qualified personnel should install, replace, and service the 

equipment. 

When drilling the vehicle, verify that there are no cables in the vicinity. Failure 

to do so may result in severe damage. 

Install a 5 A fuse on the Ignition and Main Power connections. 

Never install the unit with exposed board (opened case). This can cause the 

inadvertent shorting and unit damage. 

Connect all the required cables to the Helios wire harness before connecting it 

to the unit. 

For vehicle wiring database, see the Wiring section on Starcom Online Help 

page (Chapter 7 – Monitoring > Help > Wiring). 

Leave the RS232 wire set with Molex connector from the Helios wire harness 

accessible for easy connection with a portable computer. 

 

Tools required for installation 

The following tools are required for installing Helios: 

 Electric drill and/or screwdriver 

 Cone drill 

 Adapter for Phillips (cross-head) screws 

 Phillips, flat-tip, and star screwdrivers (various sizes) 

 Wire cutter 

 Test lamp and/or voltmeter (use of voltmeter is preferred and 

recommended) 

 Electrical insulation tape 

 Regular and drilling head screws 

 Insulation sleeve or soldering iron and solder 
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Positioning the unit in the vehicle 

Do not install Helios beneath metal parts, for example under a shelf supporting 

loudspeakers. To maintain high-quality reception, it is highly recommended to 

install Helios in a location that provides an uninterrupted view of the sky. 

Consider any of the following locations for installing the unit: 

 Within the vehicle dashboard 

 Near to the glove compartment 

 Behind instrument panel 

 In the center console 

 Under the steering column 

Ensure that Helios is not placed near heat sources, water pipes, or the vehicle 

computer. 

The following image shows some of the possible installation locations. 

 

 

Use alcohol to clean the surface to which you decided to attach the unit. 

Secure the unit in its chosen location using cable ties and ensure proper 

concealment of all wires.  

Dashboard 

Instrument 
Panel 

Steering 
Column 

Glove 

Compartment 

Center 
Console 
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Donning the Helios TT waterproof casing 

Insert the Helios TT unit in the larger part of the waterproof casing so that the 

GPS antenna side of the unit corresponds to THIS SIDE UP side of the casing, 

as shown in the image below. 

 

 

 

Insert the Helios TT wire harness into the smaller part of the waterproof casing, 

as shown in the image below. 
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Connect the wire harness to the Helios TT unit. 

 

 

 

Fold the sides of the larger part of the casing, as shown in the image below. 
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Slide the smaller part of the casing onto the device. Make sure that THIS SIDE 

UP sides of the casing parts correspond, as shown in the image below. 

 

 

 

Unfold the sides of the larger part of the casing over the smaller part and pull 

them up as tight as possible, as shown in the image below. 
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Bend the wire harness sleeve on the smaller casing part. 

 

 

Secure the sleeve with a zip tie. 
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Cover the sleeve with insulating tape. 

 

 

 

The unit is ready for installation. 
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Helios TT pin out 

Pin 

No. 

Function Color Designation Notes 

1 Analog / digital 

input 

 

Yellow/Blue Input (+) Digital input is designated as 

"Door" by default. 

Analog can be used for fuel or 

temperature measurement. 

See Chapter 4 – Configuration 

> Hardware > Analog input 

configuration on Helios TT and 
Basic 

 

2 RS232 RX White Communication RS232 wire set with Molex 

connector 

3 Main Power 

8–28V DC, 1A 

Red Power Supply Main +12V or +24 V supply.  

Must be protected by a 5 A fuse 

4 Key (Ignition) Yellow Input (+) Indicates the vehicle ignition 

state 

5 N/A    

6 Keypad/Dallas Blue/White  Keypad connector 

7 RS232 TX Red Communication RS232 wire set with Molex 

connector 

8 GND Black 

Black 

 

GND  

9 Immobilizer 

and/or Gradual 
Stop 

Blue Output (-) Install with an external relay. 

See Appendix D – Immobilizer 
and Gradual Stop 

 

10 N/A    
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The following images show Helios TT unit and Helios TT board with Micro-SIM 

card holder. 

 

 

 

The following image shows Helios TT wire harness. 
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The following image shows Helios TT Simulator cable. 

 

 

The following image shows Helios TT TTL computer cable. 
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The following image shows how to connect Helios TT unit to the Simulator. 

 

 

 

Connect the Helios TT unit to the Simulator with the 10-pin wire harness.  

Connect the Helios TT unit to the computer with the TTL cable. Connect the 

Simulator power supply and plug it into an electrical outlet. Turn the Simulator 

on. 

 

Download and install the Helios TT TTL cable driver from the following link: 

http://www.ftdichip.com/Drivers/VCP.htm 

 

  

http://www.ftdichip.com/Drivers/VCP.htm
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Helios Basic 10-pin pin out 

Pin 

No. 

Function Color Designation Notes 

1 Analog / digital 

Input 

 

Yellow/Blue Input (+) Digital input is designated as 

"Door" by default. 

Analog can be used for fuel or 

temperature measurement. 

See Chapter 4 – Configuration 

> Hardware > Analog input 

configuration on Helios TT and 
Basic 

 

2 RS232 RX Brown Communication RS232 wire set with Molex 

connector 

3 Main Power  

+12V or +24V 

Red Power Supply Main +12V or +24V supply.  

Must be protected by a 5 A fuse 

4 Key (Ignition) Yellow Input (+) Indicates the vehicle ignition 

state 

5 CAN High Gray/Black CAN Bus 

connection 

CAN + 

6 Keypad/Dallas Blue/White 

Red 

Black 

 

 Keypad connector 

 

7 RS232 TX Red 

Black 

Communication RS232 wire set with Molex 

connector 

8 GND Black GND  

9 Immobilizer 

and/or Gradual 
Stop 

Blue Output (-) Install with an external relay. 

See Appendix D – Immobilizer 
and Gradual Stop 

 

10 CAN Low Gray/Blue CAN Bus 

connection 

CAN - 
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The following image shows Helios Basic 10-pin unit. 

 

 

 

 

The following image shows Helios Basic 10-pin wire harness. 
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The following image shows Helios Basic 10-pin Simulator cable. 

 

 

The following image shows how to connect Helios Basic 10-pin unit to the 

Simulator. 
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Helios Advanced 24-pin pinout 

Pin 
No. 

Function Color Designation Notes 

1 Immobilizer 
and/or Gradual 
Stop 

Blue Output (-) Install with an external relay. 
See Appendix D – 
Immobilizer and Gradual Stop 
 

2 Door Unlock Gray Output (-) Install with an external relay. 
See Appendix C – Central 
Locking System Configuration 
 

3 RS232 TX Orange/Blue  Communication RS232 wire set with Molex 
connector. Enables direct 

connection to a computer 

 

4 Key (Ignition)  Yellow Input (+) Indicates the vehicle ignition 
state 
 

5 Main Power  
+12V or +24V 

Red Power Supply Main +12 or +24V supply.  
Must be protected by a 5 A 
fuse 
 

6 GND  Black 

 

  

7 Keypad/Dallas  Blue/White  Communication  Keypad connector 
 

8 Emergency Button  

 

White Input (-)   

9 Microphone (+) / 
or Extra Digital 

Input 1 (-) 

Orange Audio Hands Free Kit connector. In 
case HFK is not connected, 

you can cut the connector 
and use pin 9 as Extra Digital 
Input 1 

 

10 Speaker (+) / or 
Extra Analog 
Input 3 (-) 

Violet  Audio Hands Free Kit connector. In 
case HFK is not connected, 
you can cut the connector 
and use pin 10 as Extra 

Analog Input 3 
 

11 Analog 1 Yellow/Blue Input (+) Usually used for fuel or 
temperature measurement 
 

12 CAN High Black/Gray CAN Bus 
connection 
 

CAN + 

13 Door Lock Gray/Orange Output (-) Install with an external relay. 
See Appendix C – Central 

Locking System Configuration 
 

14 Arm Orange/White 
 

Input (-)  

15 RS232 RX Blue/Black Communication  RS232 wire set with Molex 

connector 
 

16 Door Green Input (-)  
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17 Disarm Pink Input (-) Alarm system disarming input 
 

18 GND Black   

19 Siren/Vehicle 
Horn  

Red/Black  Output (-) Install with a relay (according 
to the vehicle voltage +12V 
or +24V) 
 

20 Odometer White/Black Pulse Counting 
Input (+) 
 

Connect to pulse generator* 

21 Microphone (-) /or 

Extra Digital  
Input 2 

Green/Red Audio Hands Free Kit connector. In 

case HFK is not connected, 
you can cut the connector 
and use pin 21 as Extra 

Digital Input 2 
 

22 Speaker (-) /or 

Extra Digital  
Input 3 
 

Blue/Red Audio Hands Free Kit connector. In 

case HFK is not connected, 
you can cut the connector 
and use pin 22 as Extra 
Digital Input 3 
 

23 Analog 2 Violet/White Input (+) Usually used for fuel or 
temperature measurement 
 

24 CAN Low Gray/Blue CAN Bus 
connection 
 

CAN -  

 
* The odometer input informs the system whether to measure mileage by 

counting odometer pulses or by calculating the distance traversed by the 
vehicle using GPS. The odometer can count pulses from any type of pulse 
generator. 
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The following image shows the pin numbering on the Helios 24-pin J1 

connector. 
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The following image shows the pin correspondence to different auto 

components. 
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Helios Hybrid connection 

 

 

Connect the external antenna to the satellite modem. 

Take a 10-pin wire harness and isolate the RED Power cable (+), BLACK GND 

cable (-) and RS232 connector from the rest of the harness. 

Connect the special RS232 Male to Male cable to RS232 connector on the 

satellite modem wire harness and to the RS232 connector on the Helios wire 

harness. 

Connect the RED Power cable (+) from the satellite modem wire harness to 

+12V or +24V power source. Connect the BLACK GND cable (-) from the 

satellite modem wire harness to ground. 
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7. Monitoring 

 

After the unit is installed in the vehicle, you can monitor its status on Starcom 

Online. Starcom Online is a web based fleet management application with a 

flexible event generator which allows to set customizable notifications and 

alerts. 

In your browser, go to http://www.starcomsystems.com/online. Enter your 

username and password in the Username and Password fields, and click 

Sign in. 

 

Starcom Online horizontal menu bar features the following categories: 

• Home – lists the most recently accessed units, including their location. 

• Resources – allows to manage the unit and customer information. 

• Plans – allows to create and manage events and alerts. 

• Monitor – monitors the events and alerts from the unit. 

• Map – displays the actual location of the unit on the map. 

• Reports – generates reports of the unit activity. 

• Profile – allows to configure your user properties. 

• Help – contains tutorials and knowledge base. 

  

http://www.starcomsystems.com/online
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Home 

The Home section shows recently accessed units and latest site updates. 

 

In the Home section, you can find the following additional links: 

Live status – displays the current status of all live units, as shown in the 

following image. 

 

Full list – opens the Resources section that displays a full list of all your units. 

Location – opens the Map section that displays a map showing the current 

location of the unit. 

Quick List – links that enable you to access the Resources and Plans sections.  
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Resources 

The Resources section shows all your units. 

 

On the left side, the Resources section features the following tabs: 

Units – lists the units. 

Groups – lists the groups of units and helps you create new and modify the 

existing groups. 

Drivers – lists the drivers. 

Users – lists the users and helps you create new and modify the existing users. 

Perimeters – lists perimeters and helps you define new and modify the 

existing perimeters. 

 

Units 

The Units page features the Details area, which arranges the unit 

information in the following columns: 

Number – the unit serial number. Clicking on the unit number link will 

display the Unit Information page, where you can modify the unit 

information. 

Name – displays the icon and the name of the unit. Clicking on it will 

reveal a pop-up menu with the quick access links to the Map and the 

Reports sections. 

Cellular Number – displays the phone number of the SIM card installed 

in the unit. 
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Last Message – displays the time and date of the last message 

transmitted by the unit. 

To create a new unit, click New (not available for evaluation kit users). 

The Unit Information page opens. 
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Active – when selected (set by default), makes the unit active on 

Starcom Online. To make the unit inactive, deselect this checkbox. No 

data will be collected for inactive units; they will appear as dimmed in 

the units list. 

Use this section to enter the unit Number and Name. In the Cellular 

Number field, enter the number of the SIM card installed in the unit. In 

the Unit Type list, select Helios. Use the Terminal list to select the 

type of terminal connected to the unit. 

Specify Vehicle Model and Vehicle Color. Choose the Icon which will 

represent the unit. 

No Activity Alert (Hours) – used to receive an alert when the unit has 

stopped transmitting. The default value is 336 hours (2 weeks). 

In the Users window, click on the plus (+) sign on the right and start 

typing the name of the user you want to make the unit available for in 

the Search field. The name of the user will appear in the dropdown list. 

Click on it to add it to the Users list. To remove the user, click on the 

minus sign (-) on the left of the user name. 

In the Groups window, click on the plus (+) sign on the right and start 

typing the name of the group you want to make the unit available for in 

the Search field. The name of the group will appear in the dropdown list. 

Click on it to add it to the Groups list. To remove the group, click on the 

minus sign (-) on the left of the group name. 

 

Use the Cellular Notification section to configure the cellular 

notifications for different events. 

Notify Address 1-4 – enter the cellular numbers you want to use to 

send commands to the unit, or to receive notifications on when the 

events occur. 

Message – modify the notification message format. The following 

parameters are available: |TIME| |NUMBER| |VEHICLE| |REASON| 

|KEY| |DOOR| |HOOD| |SPEED| |MILEAGE| |XY| |BATTERY|. 

Language – select the language in which you want to receive the 

message. 
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Units (kph/mph) – select the measurement you want to receive the 

speed data in. 

Allow commands from any cellular number – select this if you want 

to be able to send commands to the unit from any cellular phone, and 

not only from the addresses specified above. 

Allow status requests from any cellular number – select this if you 

want to allow status requests from any cellular phone, and not only from 

the addresses specified above. 

For more information, see Appendix I – Cellular Phone Commands. 

In the Available reasons list, select the reasons you want to receive 

an alert for and click Add. The reasons will be moved to the Notify for 

list. 

 

Clicking on Captions will reveal the Captions section. 

 

This section features the captions for various fields, like unit inputs, 

outputs, transmit reasons, etc. which are used throughout the system. 
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The Analog settings help you configure the use of the unit analog 

inputs, which are usually used for fuel or temperature measurement. 

For more information, see Appendix F – Fuel Measurement and 

Temperature Sensor guide. 

 

When finished, click Apply. The new unit is saved. 

 

To modify a unit, in the Units page, click on the unit name link of the 

unit you want to modify. The Unit Information page appears. Modify the 

unit details as required. Click Apply. The modified unit details are saved. 

To delete a unit, in the Units page, click on the unit name link of the 

unit you want to delete. The Unit Information page appears. Click 

Delete. The unit is deleted. 
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Groups 

You can create new and modify the existing groups of units. 

 

To create a new group, click New. The Group page opens. 

 

 

In the Name field enter the name of the new group. 
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In the Units window, click on the plus (+) sign on the right and start 

typing the name of the unit you want to make the unit available for in 

the Search field. The name of the unit will appear in the dropdown list. 

Click on it to add it to the Units list. To remove the unit, click on the 

minus sign (-) on the left of the unit name. 

In the Users window, click on the plus (+) sign on the right and start 

typing the name of the user you want to make the unit available for in 

the Search field. The name of the user will appear in the dropdown list. 

Click on it to add it to the Users list. To remove the user, click on the 

minus sign (-) on the left of the user name. 

In the Sharing section, click the respective checkbox, if you want the 

group to Share Perimeters, Share Events, or Share Drivers. 

Click Apply. The new group is saved. 

 

To modify a group, in the Groups page, click on the group name link of 

the group you want to modify. The Group page appears. Modify the 

group details as required. Click Apply. The modified group details are 

saved. 

To delete a group, in the Groups page, click on the group name link of 

the group you want to delete. The Group page appears. Click Delete. 

The group is deleted. 
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Drivers 

You can create new and modify the existing drivers. 

 

To create a new driver, click New. The Drivers page opens. Here you 

can enter the new driver information. 

 

 

In the Code field, you can specify the iButton or keypad code of the 

driver. 

Click Apply. The new driver is saved. 

 

To modify a driver, in the Drivers page, click on the driver name link of 

the driver you want to modify. The Drivers page appears. Modify the 

driver details as required. Click Apply. The modified driver details are 

saved. 

To delete a driver, in the Drivers page, click on the driver name link of 

the driver you want to delete. The Drivers page appears. Click Delete. 

The driver is deleted. 
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Users 

You can create new and modify the existing users. 

 

 

 

To create a new user, click New. The Users page opens. Here you can 

enter the new user information and define their access permissions. 
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Besides entering the user information, you can select the following 

options: 

All units –all the user’s units will be displayed on the Map page. If this 

option is disabled, only the selected unit will be displayed.  
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Show coordinates in reports – the user’s reports will include the GPS 

coordinates. 

Flash Maps – enables the user to see flash maps. 

Report Access – allows to select which reports will be accessible for 

the user. 

Google Maps access – enables Google Maps access on the Maps page. 

Allow status requests – enables the user to make unit status 

requests. 

Allow outgoing commands – enables the user to send commands to 

the unit. 

Allow stopping vehicle – enables the user to send a command to the 

unit which will stop the vehicle. 

Allow logic state changing – enables the user to change the unit logic 

state. 

Allow clearing fleet – enables the user to send Clear Fleet command 

to the units. 

Cellular Commands – enables the user to send commands to the unit 

from a cellular phone. 

Cellular Notification – enables the user to receive cellular 

notifications. 

Mobile Application – enables the user to use Starcom Mobile 

application. Olympia Tracking, Starcom Mobile application, allows to 

receive cellular notifications to your mobile phone. To install, use the 

following link: http://starcomsystems.com/m/ (compatible with Android 

/ Apple IOS). 

Lock account after 5 bad login attempts – locks access to Starcom 

Online account after the user has made 5 bad login attempts. 

Force password changing once a month – requires the user to 

change the password once a month. 

Allow editing cellular number – enables the user to edit the phone 

number of the SIM card installed in the unit.  

http://starcomsystems.com/m/
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Allow changing tracking interval – enables the user to change the 

time of the unit tracking interval. 

 

Permissions allow you to define the viewing and editing permissions of 

the user for all the sections of the site. 

 

After you configured all the parameters, click Apply. The new user is 

saved. 

 

To modify a user, in the Users page click on the user name link of the 

user you want to modify. The Users page appears. Modify the user 

details as required. Click Apply. The modified user details are saved. 

To delete a user, in the Users page click on the user name link of the 

user you want to delete. The Users page appears. Click Delete. The 

user is deleted. 
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Perimeters 

You can create new and modify the existing perimeters. 

 

 

To create a new perimeter, click New. The Perimeters page opens. In 

the Name field, enter a name for the new perimeter. 

 

 

 

To create a new perimeter, click Options > Tools > Create new 

perimeter at the top right corner of the map. Click once anywhere on 

the map to start the perimeter selection (this point would be the top left 

corner of the perimeter). Move the mouse and click again anywhere on 

the map to finish the perimeter (this point would be the bottom right 

corner of the perimeter).  
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In the Perimeter Name field, enter the name of the perimeter. Click 

Ok. The new perimeter is saved and appears on the map. 

 

To view/edit the GPS parameters of the perimeter, click Edit raw 

values. The raw parameters appear. 
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Modify the values as required. Click Apply to save the changes. 

 

After you made all the changes on the Perimeters page, click Apply. 

The perimeter details are saved and the new perimeter appears in the 

list on the Resources section. 

 

To modify a perimeter, in the Perimeters page click on the perimeter 

name link of the perimeter you want to modify. The Perimeters map 

page appears. Modify the perimeter as required. Click Apply. The 

modified perimeter is saved. 

To delete a perimeter, in the Perimeters page click on the perimeter 

name link of the perimeter you want to delete. The Perimeters map page 

appears. Click Delete. The perimeter is deleted. 
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Plans 

The Plans section enables you to create usage plans and to view plans that 

already exist. 

 

On the left side, the Plans section features the following tabs: 

Basic – allows to set up basic plans for LCU500 units. Do not use. 

Advanced – allows to set up advanced plans for LCU500 units. Do not use. 

Events – allows to create events for your units. 

To create a new event, you need to create an event Type first. Click Types. 

The Types page opens. 

 

In this section, you can see the types of events already created in the system. 

You can use one of them, or create a new type. 
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To create a new event type, click New. Enter the name of the event type in 

the Name field. Leave Day of the week and Time Range as "Changeable", 

later you will be able to change these settings in the event itself. 

 

Click the Add Event button and select the event type you want to create from 

the dropdown list. 
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Set the necessary Value. You can leave the Condition as "Changeable", later 

you will be able to change it in the event itself. Select the necessary operand 

in the Operand list, as follows: 

And – when you create several events, this event and the following one will 

be performed simultaneously. 

And then – when you create several events, the following event will start only 

after the first one is performed. 

Transmit – the event will be transmitted. 

End – ends an event. For example, you can create an output event, which 

after it performs the necessary actions will simply end. 

You can create a complex event type, which consists of several events. 

When finished, click Apply. The new event type is saved. 

 

To create a new event, click New in the Events section. 

 

Enter the name of the event in the Name field. In the Units list, select the 

units you want to include in the event and click Add. The units will be moved 

to the Available for list. 
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Enter the cellular number and email address to receive the event notification. 

If you select the Monitor checkbox, the event will be displayed on the Monitor 

page (see below) in real time. 

Click the Add Event button and select the type of the event you want to create 

from the dropdown list. 

 

 

Specify the time and date range and the event condition. 

When finished, click Apply. The new event is saved. 

You can create a complex event, which consists of several events. 
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For example, let’s create an event, which will send an alert when the vehicle 

goes over a certain speed in a specific location. 

Go to Types and click New. 

 

Enter the event type name and tick the Changeable checkboxes for the Day of 

the week and Time range. 

Click Add Event. 

 

Select Speed in the Type list. Select Higher in the Condition list. Click the 

Changeable checkbox in the Value field. Select And in the Operand list. 

Click the Add Event button again. 
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Select Perimeter in the Type list. Select Changeable in the Perimeter list. 

Select Changeable in the Condition field. Select Transmit in the Operand 

list. 

Click Apply. The new event type is saved. 

 

Now, go to Events and click New. 

 

Enter the name of the event in the Name field. In the Units list, select the 

units you want to include in the event and click Add. The units will be moved 

to the Available for list. 

Enter the cellular number and email address to receive the event notification. 

Select the Monitor checkbox, if you want the event will to be displayed on the 

Monitor page in real time. 

Click the Add Event button and select the High speed in a specific location 

type in the Type list. 
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Enter the name of the event in the Name field. Select the necessary time and 

date range. 

Specify the speed limit in the Speed field. 

Select the necessary perimeter in the Perimeter list. 

Select Entering in the Condition list. 

Click Apply. The new event, which will send an alert when the vehicle goes 

over a certain speed in a specific location, is created. 
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Monitor 

The Monitor section allows you to select a set of events for a specific unit type 

and to see them displayed in real time. 

 

On the left side, the Monitor section features the following tabs: 

Monitor – displays the events in real time. 

Settings – allows creating new and modifying existing monitoring events. 

To create a new event, go to the Settings tab and click New. The Details page 

opens. In the Name field, enter a name for the new event. 
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Select Helios in the Unit Type list. 

In the Units list, select the units you want to include in the event and click 

Add. The units will be moved to the Available for list. 

In the Available reasons list, select the reasons you wish to receive an alert 

for and click Add. The reasons will be moved to the Notify for list. 

Enter the cellular number and email for the notification to be sent to in the 

Notify for section. 

Press Apply. The new monitoring event is saved. 

 

Once the events are generated by the units, they will appear on the Monitor 

page. You will also receive a notification by SMS. The email notifications are 

accumulated and sent once every half an hour to avoid spamming. 
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Map 

The Map page displays the location of a single unit, or a group of units. It also 

shows the unit information and commands. 

 

 

You can select vehicle, group or driver in the dropdown list on the left. 

In the Search field, you can enter the unit number or name to be displayed. 

Once you select the unit, its location will be displayed on the map and its 

information will appear on the left. 
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The following unit information is displayed: 

 Location – the address of the last GPS position of the unit 

 Received – the date and time of last transmission from the unit 

 Reason – the reason for the transmission 

 Driver – the vehicle driver name 

 Version – the unit firmware version 
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 Location – the GPS location of the unit, including: 

 Valid – the date and time of the last location transmission from the 

unit 

 Speed – the last recorded speed of the unit 

 Mileage – the last recorded mileage of the unit 

 Coordinates – the last longitude and latitude of the unit 

 Altitude – the last altitude of the unit 

 

 IO – unit input and output information 

 

 Commands 

 Request Status – requests the current status of the unit 

 Tracking – overrides the unit transmission rate settings and forces 

the unit to transmit according to the specified interval. 

 Stop Tracking – stops the tracking command and returns the unit 

to its regular transmission rate 

 Set Output – sends a command to the unit output: Siren On/Off, 

Door Lock/Unlock, Gradual Stop On/Off, and Immobilizer Off. 

 Voice Call – initiates a voice call with the unit 

 Set Mileage – sets the specified mileage value in the unit 

 Logic State – changes the unit logic state 
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Click on the settings icon  in the bottom left corner to reveal the Map 

Options. 

 Search 

As you type the name of a search criterion in the search field, a list of matching 

names, from which you can select the required name, appears. 

 Create new perimeter – allows to create a new perimeter. 

 Edit perimeter – allows you to edit an existing perimeter. 

 Distance measurement – allows to measure the distance between two 

points on the map. 

 Shapes – shows your perimeters on the map. 

 All units – shows all your units on the map at once. 
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 Map types 

You can select the following map types: OpenStreetMap, Yandex, Google 

RoadMap, Google Satellite, and Google Hybrid. 

 

 

 

In the bottom right corner, you can see the Legend, which describes the status 

of color border around the unit icon. 
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Reports 

The Reports section allows you to generate different unit reports and to 

schedule automatically generated reports. 

 

 

On the left side, the Reports section features the following tabs: 

Instant – allows to generate reports on demand for a single unit or a group 

of units for a specific time period (date and time range). 

Schedule – allows to define scheduled reports that generate automatically on 

a daily, monthly or weekly basis. 

NOTE: The reports can be generated for the last 30 days only. 

 

You can generate the following types of reports: Work Hours, Work Hours 

Summary, Work Hours Group Summary, History, History – Technical, 

Violations, Driver Work Hours, Driver History, Driver Vehicles, Live 

Status, Events, Perimeter Entry, Analog Inputs, Fuel Consumption, 

Transmit Reasons, Monitored events, Stop. 

 

To generate a report, select the report type in the Report dropdown list. Select 

the unit or group of units in the Unit dropdown list. Specify the dates and 

times in the Date Range. Click Generate. 

 

The following is an example of a report generated for one unit on one day and 

for a specific time period. 
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The report includes a map area and tracking details area. The map area shows 

a map of the area in which the unit is located showing points of movement of 

the unit. The tracking details area lists the tracking data of the unit.  
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The pointers on the map correspond with the numbers in the address column 

of the detailed list of transmissions received from the unit. These numbers 

indicate the points of movement of the unit. The total number of map pointers 

available per report is 50. 

On the bottom of the Map section there is a Play button  that enables you to 

play back the movement of the unit on the map. 

 

To save the report, click Save  . The report can be saved as a PDF 

file, or as an HTML file in a zip. 

To export a report, click Export  . The report is exported as a CSV 

file, which can be viewed in Excel. 

To print a report, click Print  . The report appears in your default 

browser window where you can select the printer to print out the report. 

 

 

Scheduled reports 

To create a scheduled report, in the Reports section, click Schedule. 

The Schedule page appears 

 

 

Click New. The Report Scheduling page opens. 
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From the Report dropdown list, select the type of report you want to 

create. 

Tick the CSV only checkbox, if you do not want a map provided with 

the report. 

From the Unit dropdown list, select the unit or group of units for the 

report. 

From the Repeat dropdown list, select if you want the report repeated 

Daily, Weekly or Monthly. 

From the Generate At dropdown list, select the time at which you want 

to generate the report. 

The Send to field is populated with the default email address for the 

unit. You can change this address or add additional email addresses, 

separated by a semicolon.  

Click Apply. The report schedule is saved and added to the list of 

scheduled reports. 
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To modify a scheduled report, in Reports, click Schedule. In the 

Details section, under the Generate column, click the link of the report 

schedule you want to modify. The Report Scheduling page appears. 

Modify the report schedule as required. Click Apply. The modified 

schedule details are saved. 

  

To delete a scheduled report, in Reports, click Schedule. In the 

Details section, under the Generate column, click the link of the report 

schedule you want to delete. The Report Scheduling page appears. Click 

Delete. The scheduled report is deleted. 
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Profile 

The Profile section shows your profile details that were created when you 

purchased your units. You can view and modify these details as required. 

 

 

To view or modify your profile, click the Profile tab, and modify the 

information as required. 

Click Apply. The changes are saved. 
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Using Map Tooltip Format 

The Map Tooltip Format field lets you configure the information that will appear 

in the info window on the Map page when you select a unit. 

To see all the parameters that can be configured in the Map Tooltip Format 

field, click on the green question mark located to the right of the field. The Map 

Tooltip Format legend window will appear. 

 

 

Once you made all the necessary changes, click Apply. Then go to the Map 

page and check the unit info window. 

  



 
 

125 
 

Helios User Guide 

Help 

The Help section contains answers to some frequently asked questions, 

Starcom Online tutorials, and vehicle wiring database. 

 

 

 

Click on the appropriate tab to access the necessary information. 

 

Wiring 

The wiring section on Help page contains the vehicle wiring database 

that can be useful when installing Helios in the vehicle. 

To access the database, press on the Wiring tab. 
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Scroll through the pages to locate the necessary car model, or use the 

Search field. 

Once you found the necessary car model, click on the manufacturer 

name link to see the wiring details. 
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Appendix A – Unit Communication in Starcom 

Systems 

 

Helios is the mobile component of Starcom’s advanced vehicle tracking and 

fleet management system. The system uses advanced software algorithms for 

field tracking of vehicles and provides customers with a selection of real-time 

information about the tracked vehicle. The following image illustrates the 

Starcom Systems communication channels. 

 

The unit transmits messages according to the values specified in Helios 

Parameters > Transmission Rates settings (GPRS, SMS). 

When the unit’s modem is turned on, it tries to connect to the network and 

transmit via GPRS (4 attempts: 2 on the first server and 2 on the second 

server). If it fails to connect to the network, it will switch to the SMS channel 

(if it is configured to transmit via SMS) after about 4 minutes, because it makes 

four attempts to connect via GPRS. It will constantly try to transmit via SMS. 
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The next attempt to transmit via GPRS will be repeated in 5 minutes. Every 5 

minutes, the unit will attempt to connect to the network and transmit via GPRS. 

This process is illustrated in the following figure. 

 

The unit saves all the information that could not be sent in its memory. Once 

it is able to connect to the network again, it will transmit all the stored data. 

The device sends encrypted data to the routing server. When the routing 

receives it, it is decoded and encoded at the same time and sent to all the 

recipients configured in the system. 

 

The message size is 140 bytes (70 bytes data and 70 bytes header). 

 

For more information, see Routing, Control Center and SMS Notifications 

guides. 
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Appendix B – Configuring Mileage 

 

There are two ways the unit can receive the mileage readings: by GPS and by 

Odometer. 

 

GPS 

Initial settings 

Connect the Helios unit to the computer. In Installer application, go to Helios 

parameters > General and change the settings as follows: 

Mileage: Actual mileage reading that you see in the vehicle 

Fixing Factor (%): 100 

Mileage from: GPS 

 

 

Click Send to send the parameters to the unit. 

 

Accumulating data and performing calculations 

Drive the car for some distance. The unit will register a certain mileage reading. 

Compare the mileage reading in the car to the mileage reading registered by 

the unit. If they are the same, the calibration is done. 
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If the readings are different, enter the correct reading from the car in the 

Mileage filed and calculate the fixing factor as follows: 

Divide the reading in the car by the reading in the unit. Enter the received 

number as percentage in the Fixing Factor field. 

For example, if the reading in the car shows 10 and the reading in the unit 

shows 11, calculate as follows: 

10 ÷ 11 = 0.90 

In this case you will enter 90% in the Fixing Factor field. 

If the reading in the car shows 10 and the reading in the unit shows 9, calculate 

as follows: 

10 ÷ 9 = 1.11 

In this case you will enter 111% in the Fixing Factor field. 

Click Send to send the new parameters to the unit. 

 

Odometer 

Installation 

Connect the odometer pulse to the Odometer WHITE/BLACK cable on 24-pin 

Helios wire harness (Pin 20). 

 

Initial settings 

Connect the Helios unit to the computer. In Installer application, go to Helios 

parameters > General and change the settings as follows: 

Mileage: 0 

Fixing Factor (%): 100 

Mileage from: Odometer 

Current Value: 0 

Pulses Per KM: 1  
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Click Send to send the parameters to the unit. 

 

Accumulating data and performing calculations 

Drive the car for some distance. The unit will count a certain amount of pulses. 

Check the mileage reading in the car. Take this number and divide it by the 

actual number of kilometers that you've driven. For example, let’s say that the 

mileage in the car was shown as 125,000, and you’ve driven 50 km. 

125,000 ÷ 50= 2,500 

The result (in this case 2,500) will be your new Pulses per KM value. 

 

Final settings 

After this, go back to Installer > Helios parameters > General. Read the 

data from the unit and change the following parameters: 

Pulses Per KM: The value that you've calculated (for example 2,500). 

Mileage: Actual mileage reading that you see in the vehicle. 

Click Send to send the new parameters to the unit. 

 

From that point on, the unit will show accurate mileage readings. 
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Appendix C – Central Locking System 

Configuration 

 

When installed in a vehicle with central locking, the Helios unit can be 

configured in two ways: 

1. Helios can control the central locking system to lock/unlock the vehicle doors 

when it changes the logic state from Armed to Disarmed and vice versa. The 

control can be performed manually, by sending a command, or automatically, 

when Helios enters Armed/Disarmed logic state according to the Logic settings, 

or specified event settings. 

2. The central locking system can control the Helios logic state, changing the 

Helios logic state from Armed to Disarmed and vice versa each time the vehicle 

doors are locked/unlocked. 

 

Installation 

Before making any changes to the vehicle wiring, verify which type of locking 

system is in use. If you can identify the location of the locking engine and gain 

access to its terminals, you may be able to make a direct connection without 

adding external relays. 

(–) (–) Locking 

In this locking method, a negative pulse activates the locking mechanism and 

the next negative pulse activates the unlocking mechanism. This is called (–) 

(–). It is also possible to use (+) (+). 

For vehicles with (–) (–) locking systems, you can wire the unit without adding 

any external relays, as follows: 

Connect Door Lock GRAY/ORANGE cable on 24-pin Helios wire harness (Pin 

13) to the vehicle central locking input responsible for the Lock command. 

Connect Door Unlock GRAY cable on 24-pin Helios wire harness (Pin 2) to the 

vehicle central locking input responsible for the Unlock command. 

  



 
 

133 
 

Helios User Guide 

 

 

If you cannot gain access to the locking engine, you can use external relays 

and connect to the existing wires that lead to the locking engine. The following 

image illustrates this connection. 
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Serial Locking 

This method requires the addition of two external relays. Wire them as follows: 

 

 

Arm/Disarm 

You can connect the Helios Arm/Disarm function either as a standalone system 

or in conjunction with the vehicle Arm/Disarm system. 

 

Standalone Arming 

Arming is performed by passive arming, remote control, or transponder. 

Disarming is performed by unlocking the doors, keypad, remote control, 

or transponder.  
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Connecting to the vehicle Arm/Disarm system 

Locate the vehicle alarm system and connect the Arm 

ORANGE/WHITE cable on 24-pin Helios wire harness (Pin 14) to the 

vehicle alarm system Arm cable with a diode. Also, connect the Disarm 

PINK cable on 24-pin Helios wire harness (Pin 17) to the vehicle alarm 

system Disarm cable with a diode.  

 

NOTE: If the vehicle’s existing alarm system uses (+) (+) commands, 

insert external relays to swap the logic to (–) (–). 
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Appendix D – Immobilizer and Gradual Stop 

 

NOTE: Check the vehicle voltage (+12 V or +24 V) before installation and use 

the proper voltage relays. 

Helios can bring the vehicle to a gradual stop when necessary. For example, if 

the vehicle is reported stolen, the control center can issue a Gradual Stop 

command. 

When there is no alarm, the Immobilizer/Gradual Stop BLUE cable on 24-pin 

Helios wire harness (Pin 1) grounds the coil No. 85 (see diagram below) of the 

external relay. In this case, the relay powers the vehicle starter or fuel pump 

via pin No. 87 (see diagram below). 

When the Helios alarm is activated, the Immobilizer/Gradual Stop BLUE cable 

on 24-pin Helios wire harness (Pin 1) toggles the ground to the relay coil. As 

the duty cycle of pin 1 changes, the coil becomes gradually deactivated for 

longer and longer intervals until it is fully disconnected from ground. 

Consequently, the starter or fuel pump gradually becomes inactive, bringing 

the vehicle to a gradual stop. 
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ATTENTION! 
 

To avoid damage to the unit, 
install a DIODE on the relay, as 
shown in the following image: 
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Appendix E – Connecting a Siren 

 

Helios can be used to activate the siren. You can add an external siren or use 

the vehicle horn. 

NOTE: The vehicle horn can consume large amounts of energy and drain the 

vehicle battery quickly. 

When there is no alarm, the Siren RED/BLACK cable on 24-pin Helios wire 

harness (Pin 19) disconnects the coil No. 85 (see diagram below) of the 

external relay from ground. In this case, the relay disconnects the siren, which 

is connected through the pin relay No. 87 (see diagram below). 

When the Helios alarm is activated, the Siren RED/BLACK cable on 24-pin 

Helios wire harness (Pin 19) grounds the relay coil. As a result, the siren is 

activated through the relay. 
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ATTENTION! 
 

To avoid damage to the unit, 

install a DIODE on the relay, as 

shown in the following image: 
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Appendix F – Fuel Management 

 

Fuel management allows the user to monitor the fuel level in the vehicle. This 

can be accomplished in several ways: 

 CAN bus FMS protocol monitoring 

 Connecting to the existing fuel gage in the vehicle 

 Installing an external fuel sensor and connecting to the Helios Analog input. 

 

FMS 

In heavy trucks that support FMS protocols J1939 and 1708 the Helios unit can 

monitor the fuel used by the vehicle per each trip. In order setup the Helios 

unit to monitor fuel used, the following settings should be performed: 

In Installer, go to Helios Parameters > Hardware and setup the Can bus 

as follows: 

 

 

On Starcom Online, go to Unit Information and open the Captions section. 

Select Can-bus in the Fuel dropdown list. When finished, press Apply. 
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Analog input 

Installation 

The fuel tank in passenger vehicles it is generally located under the back seats. 

Typically, it has three or five wires: 

1. Fuel pump wire – can be identified, when the engine is running, by 

measuring +12V on this cable. 

 

2. Ground – 1 or 2 wires. 

 

3. Fuel gauge (level) wire (analog) – can be identified by grounding 

(connecting to the body of the vehicle) the analog wire. If the connection 

is correct, the fuel level will rise to FULL (NOTE: In some vehicles the gage 

will not rise at once, but gradually). When the engine is running, you can 

measure 0 up to +28V depending on the fuel level. This voltage may vary 

between different vehicles and requires calibration. 
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4. Fuel warning LED (digital) – Not present in all vehicles. When the fuel 

level falls below a critical level, this wire lights a warning lamp on the 

dashboard. Connecting your testing lamp to this wire also causes the 

warning lamp on the dash board to light up. 

WARNING: Do not connect negative voltage to the fuel pump, as this may 

cause damage! 

 

Connect the fuel gauge wire to Analog 1 YELLOW/BLUE cable on 24-pin 

Helios wire harness (Pin 11), or to Analog 2 VIOLET/WHITE cable on 24-pin 

Helios wire harness (Pin 23). 

After connecting the analog input to the sensor, you need to configure the 

correct analog input that will be used for fuel level monitoring and calibrate 

the analog input to the correct values of the sensor. 

 

Configuration 

In Installer, go to Helios Parameters > Hardware. 

Select 0-15v or 0-27.5v in the Analog 1 or Analog 2 field according to the 

voltage range measured on the analog input used for fuel level monitoring. 
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In the Fuel Input dropdown list, select the analog input and the slope of the 

monitored fuel level. 

The slope is determined as the ratio between the voltage on the fuel tank and 

its contents. 

For example, if the voltage level is going down as the fuel tank is being 

emptied, then there is a direct ratio between them and therefore the slope is 

positive. In other words, a positive slope will appear if the full tank 

measurement is 10V, for example, and empty tank is 0V. 

If the fuel tank voltage level is increasing as the fuel tank is being emptied 

(which is the most common case), then the ratio between the voltage level 

and the fuel tank is an inverse ratio, and therefore the slope is negative. In 

other words, if the full tank measurement is 0V and half-full tank is 6V, then 

the graph line slope will be negative. 

Analog 1 - Positive slope – select this option, if you’re using the Analog 1 

input for fuel level monitoring, and if the fuel graph line slope is positive. 

Analog 1 - Negative slope – select this option, if you’re using the Analog 1 

input for fuel level monitoring, and if the fuel graph line slope is negative. 

Analog 2 - Negative slope – select this option, if you’re using the Analog 2 

input for fuel level monitoring, and if the fuel graph line slope is negative. 

Analog 2 - Positive slope – select this option, if you’re using the Analog 2 

input for fuel level monitoring, and if the fuel graph line slope is positive. 

 

Select the Fuel algorithm v2 option for more accurate fuel level monitoring. 

 

Once all the necessary parameters are set, press the Send button to send the 

changes you made to the unit. 
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On Starcom Online, go to Unit Information and open the Captions section. 

Select the correct analog input in the Fuel dropdown list. When finished, press 

Apply. 

 

 

 

 

If you're using a direct connection to a fuel gauge (tank), select the 

Averaged option. 

When using an external fuel sensor, select the Direct option. 
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Calibration 

When using the Analog input to read fuel the unit and the software should be 

calibrated to the sensor readings. The calibration can be done in 2 ways: 

 Manual calibration – done by manual reading of the voltage levels of the 

sensors in different levels. To perform an accurate calibration at least 5 

readings must be taken: 0%, 25%, 50%, 75% and 100% of the fuel tank. 

Once you have the readings, use the Fuel Calibration table that can be 

found at the following link:  

http://www.starcomsystems.com/jstoys/fuelcalc2.htm in order to calculate 2 

linear parameters. 

Using the fuel calibration table: 

Select the correct voltage range measured on the analog input used for fuel 

level monitoring (0-15 V or 0-27 V). 

Enter the measured voltage against the percentage of the fuel level. 

 

 

Click . The output will be displayed in the linear parameters. 

 

  

http://www.starcomsystems.com/jstoys/fuelcalc2.htm
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The received "a" and "b" parameters should be entered accordingly in the 

Unit Information > Captions section on Starcom Online. 

In order to see the fuel level in percentages in the reports, enter "Fuel" 

instead of Analog 1 in the Analog 1 field, and enter "%" instead of "v". 

 

 

 

 

 Automatic Calibration – the voltage parameters of the fuel readings can 

be calculated automatically by the system. In order to do so, the vehicle 

must fuel the tank to 100% and then use the vehicle for a period of 2 

additional refuels of 100%. Note that the lower the level of the fuel will be 

prior to the refuel, the more accurate the reading and calibration will be. 

In order to do the automatic calibration, after the 2nd refuel, on Starcom 

Online, go to Unit Information and open the Captions section. Select 

the correct analog input in the Fuel dropdown list and click on Automatic 

calibration button. When finished, press Apply. 
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Appendix G – CAN Bus Connection 

 

Controller Area Network (CAN) bus is a multiplexed wiring system used to 

connect intelligent devices such as Electronic Control Units (ECU's) onto 

vehicles, allowing data to be transferred in a low-cost and reliable manner. 

CAN bus uses two dedicated wires for communication. The wires are called 

CAN High and CAN Low. When the CAN bus is in idle mode, both lines carry 

2.5 V. When data bits are being transmitted, the CAN high line goes to 3.75 V 

and the CAN low drops to 1.25 V, thereby generating a 2.5 V differential 

between the lines. 

To identify the actual CAN bus wires look for a twisted pair of thin wires. They 

can be found all over the vehicle, sometimes in with a conventional main loom. 

In most vehicles, the CAN wires are placed in the diagnostic plug on the driver's 

side, usually from below. 

While the vehicle is stationary and the ignition is on, the CAN wires run a speed 

pulse signal. You can use a LED device, which measures pulses above 1.5-2 V, 

to identify the CAN wires. The high speed pulses will signify the CAN High wire, 

the low speed pulses – the CAN Low wire. 

 

Installation 

Connect the CAN High wire to CAN High BLACK/GRAY cable on 24-pin Helios 

wire harness (Pin 12). 

Connect the CAN Low wire to CAN Low GRAY/BLUE cable on 24-pin Helios 

wire harness (Pin 24). 
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Configuration 

After connecting the CAN wires, connect to the Helios unit with a computer and 

update the vehicle model from the existing database. 

In Installer, go to Technical > Helios Canbus. 

 

 

Press the Update Database button  . 

Select the vehicle type in the Type dropdown list. For trucks choose FMS. 

Select the vehicle model in the Model list, select the production year in the 

Year list, and click Connect. 

The vehicle data will appear. 
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Adding a new vehicle to the database 

When Helios is installed in the vehicle that is not present in the database, you 

need to create it by identifying the CAN bus signals and manually adding the 

vehicle to the database. 

In the Helios Canbus window press the New Vehicle button  

. 

Enter the new vehicle details, select the Lookup tab and start identifying the 

CAN signal. 

Choose any input (for example Door) and identify the value of the pulse signal 

as follows. Select Door in the Field Description dropdown list and Field Type 

dropdown list. 

 

 

The door can only have 2 values: Open – 1, or Closed – 0.Open the vehicle 

door. While the door is open, enter 1 in the Current Value field and click 

Search. The data of all the signals from the vehicle with the current value of 

1 will be displayed in the Index Code window. 

Close the door, change the Current Value to 0 and click Search. You will see 

less data in the window. About half of the signals will be eliminated. Only the 

signals that changed their values to 0 will be left. 

Open the door again, enter 1 in the Current Value field and click Search. 

Even less data will appear in the window (the signals from the previous amount 

that changed their values to 1). 

Repeat this process decreasing the number of signals until you’re left with one 

identified Door signal. 

After the signal has been found, select the row of the signal in the Index Code 

window. Click on the Save Field button to save this value to the new vehicle 

definition. 
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Use this procedure to find additional values. 

If you want to identify the RPM value, accelerate the motor until it reaches 

1000 RPM and search for its value at the same time. Then decrease number 

of signals by searching for the other values, such as 800 RPM, 500 RPM, etc. 

For more complicated signals, you can use the Error Range field. For example, 

when the gas pedal is pressed hard, the RPM will show approximately 2, which 

would be about 2000. However, this value isn't accurate. You can enter an 

Error Range of about 200. Then perform the search while keeping the RPM 

around 2000. 

Regarding fuel, for example, if you have approximately 70% fuel in the tank, 

look for the value of about 70 (the data displayed in percentage). Use an Error 

Range of around 5-10%. 

 

Once all the signals are identified, go to the Information tab and review the 

fields. 

 

 

Click the Save Information button to save the data. 

Click the Update Database button to save the new information to Starcom 

CAN Bus Database. 

Open Helios Parameters > Hardware. In the Canbus Vehicle section, select 

your vehicle from the list and click Send button to send the definitions to the 

unit. 
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In the Unit Status window you will see a new RPM tab. Request status several 

times to see that the RPM data is updated, which means that Helios is receiving 

the readings from CAN Bus. 

 

 

OBD II Connection 

This direct connection to the vehicle’s computer through the on-board 

diagnostics connector allows to receive the most accurate information about 

the vehicle’s speed, mileage, RPM, and fuel (where available). 

 

Installation 

To establish Helios connection to OBD-II, connect the OBD-II connector pins 

to the Helios CAN wires the following way: 

Helios wire harness: OBD-II connector: 

CAN High – BLACK/GRAY cable (Pin 12) CAN-High – Pin 6 

CAN Low – GRAY/BLUE cable (Pin 24) CAN-Low – Pin 14 
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The OBD-II connector can usually be found either behind or below the 

dashboard, behind the glove compartment, behind the radio, or below it. 

NOTE: Be careful, do not short the two wires! 

 

Testing 

After the unit was properly installed, you should test the connection. Open the 

Installer Application, go to Technical > Helios Canbus, select OBD-II as the 

vehicle type, and click Connect. If everything is correct, you will see the 

information that the unit can retrieve from the vehicle, as shown in the 

following image. 

 

 

NOTE: The mileage displayed is the mileage registered since the codes were 

last cleared. It will be used by the unit as a relative mileage to count the 

mileage the vehicle has covered and will not be used as an absolute value, so 

don’t worry if it does not match the actual mileage in the vehicle. 

 

Configuration 

After validating that the data is correct, open Helios Parameters > 

Hardware. In the Canbus Vehicle section, select OBD-II in the Type list, ALL 

in the Model list, and 0 in the Year list. Click Send and make sure you receive 

a response from the unit. 
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Finally, use the Unit Status window to send a Mileage-Set KM command to 

the unit with the current vehicle’s mileage. 
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Appendix H – Using Keypad with RF Relay 

 

You can use an external RF relay (up to 3 units), which will be activated by a 

keypad code, to perform the immobilizer functions. 

 

Configuration 

In Installer application, go to Helios Parameters > Outputs, enable the 

Use keypad RF instead of Immobilizer output option. 

Select Immobilizer On when Armed, if you’re using a Normally Closed relay. 

Select Immobilizer On when Idle, if you’re using a Normally Open relay. 
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In Installer, go to Helios Parameters > Driver IDs and configure the codes 

in the following way. 

 

 

The first 3 code fields are reserved exclusively for the relay units (up to 3). If 

you’re using one relay unit, enter its number in the first field and enter 0000 

in the following two fields. 

Code field number 4 and the remaining fields will be used for the driver codes, 

which will be activated by using the keypad. In this case code 1234 will be 

used on the keypad to close the relay and enable the vehicle ignition. 

The relay code is indicated on the sticker. For example, the relay code in the 

following image is A617. 
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Installation 

The following image shows the relay and socket with cables. 

 

 

The following diagram illustrates the relay cables connection. 

 

 

1. Relay connection 1 

2. Relay connection 2 

3. Main power +12V or +24V (usually RED) 

4. Data (GRAY) – NOT IN USE 

5. GND x 2 (-) (usually BLACK)  
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Appendix I – Cellular Phone Commands 

 

You can use a cellular phone to send commands to Helios. 

On Starcom Online, go to Unit Information and make sure that the unit is 

configured to receive commands from a cellular phone. 

The following table lists the SMS text commands supported by the system. 

Command Description 

AS Activate Siren 

DS Deactivate Siren 

AI Activate Immobilizer 

DI Deactivate Immobilizer 

LD Lock Doors 

UD Unlock Doors 

AG Activate Gradual Stop 

DG Deactivate Gradual Stop 

STAT Status Request 

 

Send an SMS text message in the following format: 

 

COMMAND   UNIT NUMBER   STARCOM USERNAME   STARCOM PASSWORD 

 

Insert a space between the command, the unit number, and the password. 

For example, if your login credentials for Starcom Online are username: 

starcom, password: starcom1, and the unit number is 123456, you can 

activate the siren by sending the following command: 

AS 123456 starcom starcom1 
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Appendix J – Contacts 

 

For more information about Starcom Systems Company and products, please 

visit: http://www.starcomsystems.com. 

 

Support 

Comprehensive support information is available online at: 

http://wiki.starcomsystems.com/wiki/index.php/Support. 

 

Should you have any questions regarding our system, please contact Starcom 

technical support. For personalized support, use Email: 

support@starcomsystems.com, or Skype: starcom.support. 

 

 

 

http://www.starcomsystems.com/
http://wiki.starcomsystems.com/wiki/index.php/Support
mailto:support@starcomsystems.com

